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HLG Photos

HLG Photos Defined

"HLG photos” are photos that support a wider range of brightnesses (i.e., dynamic range) than do SDR
(Standard Dynamic Range) JPEG pictures. The Z 8 supports HLG with two formats: RAW (extension
“.NEF") and HEIF (extension ".HIF").

Tip: HLG
Developed for television broadcasting and other high-definition applications, Hybrid Log-Gamma
(HLG) technology is a High Dynamic Range (HDR) standard that allows for photographs with a wider
range of tones, minimizing loss of detail in highlights and shadows.
* Compared with Standard Dynamic Range (SDR), it increases the amount of detail that can be
expressed in the upper half of the tone range for greater rendering potential.
* It matches SDR in the level of detail that can be expressed in the lower portion of the tone range to
ensure compatibility with non-HDR displays.
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The Benefits of HLG

HLG photos have a wider dynamic range than those recorded using SDR. They are consequently
capable of reproducing colors in rich detail, similar to how they actually appear to the human eye.

HLG minimizes loss of detail in highlights and shadows to render a richer range of tones in all areas

of photos featuring scenes that include both bright and dark areas, such as, for example, sunsets and
sunrises. It also serves to reduce loss of detail in highlights in scenes featuring bright light sources such
as light shows or the sun.

Note: These images are concept art intended to illustrate the differences between SDR and HLG. The
tones differ from those that would be seen in the actual images.
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Taking and Editing HLG Photos

Configuring the Camera for HLG

Choosing the HLG Tone Mode

To take HLG photos, select the HLG tone mode. The selection can be made via either the i or the

photo shooting menu.

I The i Menu

Select photo mode by rotating the photo/video selector to \
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Press the i button or tap the B icon in the monitor to view the i menu for photo mode.
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Highlight [Tone mode] and press .

* Tone mode options will be displayed.
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Highlight [HLG] and press &.

* This selects the highlighted option and returns you to the i

menu.
HLG
po) [OK]0]4
§ The Photo Shooting Menu
Press the MENU button to view the menus. @

® o

After highlighting the € tab to display the photo shooting BT ODTINGVENT

. . . Primary slot selection aax >
menu, highlight [Tone mode], and press the multi selector Secondary slot function i >|
right (). Image area >

Image quality NORM >
Image size settings >
RAW recording ONE >

Highlight [HLG] and press . Tone mode (9]
« This selects the highlighted option and returns you to the
menus.

An HLG-compatible monitor is
required for the display of
pictures taken in this mode.
See the manual for details




Adjusting Image Quality

The Z 8 supports HLG with two formats: RAW (NEF) and HEIF. Depending on the option selected for
image quality, photos can be recorded only in RAW (NEF) format, only in HEIF format, or in both
formats. The selection can be made via either the i or the photo shooting menu.

| The i Menu

Select photo mode by rotating the photo/video selector to \
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Highlight [Image quality] and press .

¢ Image quality options will be displayed.

Highlight the desired option and press &.
* This selects the highlighted option and returns you to the i
menu.
* For information on the options available, see “Image Quality JPEG/HENE nomig]
Options” (L1 9). < wsc | sasc >
O] EROK



} The Photo Shooting Menu

Press the MENU button to view the menus.

After highlighting the € tab to display the photo shooting
menu, highlight [Image quality], and press the multi
selector right ().

Highlight the desired option and press &.

* This selects the highlighted option and returns you to the
menus.

* For information on the options available, see “Image Quality
Options” (L1 9).

PHOTO SHOOTING MENU
Secondary slot function
Image area
Tone mode

Image quality
Image size settings

<! RAW recording

= IS0 sensitivity settings

Image quality
JPEG/HEIF finex
JPEG/HEIF fine
JPEG/HEIF normalx

PEG/HEIF normal

JPEG/HEIF basick

<! JPEG/HEIF basic




§ Image Quality Options

The image quality options available when HLG is selected for tone mode are listed below.

Option

[RAW + JPEG/HEIF finex]

[RAW + JPEG/HEIF fine]

[RAW + JPEG/HEIF normalx]

[RAW + JPEG/HEIF normal]

[RAW + JPEG/HEIF basicx]

[RAW + JPEG/HEIF basic]

[RAW]

[JPEG/HEIF finex]
[JPEG/HEIF fine]
[JPEG/HEIF normalx]
[JPEG/HEIF normal]
[JPEG/HEIF basicx]

[JPEG/HEIF basic]

Description

Record two copies of each photo: an NEF (RAW) picture and an
HEIF copy.

* Choose options with a star ("x") to maximize the quality of the
HEIF copies. Choose options without a star (“%") to ensure that
the HEIF copies all have more or less the same file size.

» The camera displays only the HEIF copy of dual-format pictures
taken with one memory card inserted.

» If the photo was recorded with only one memory card inserted
or with [Overflow] or [Backup] selected for [Secondary slot
function] in the photo shooting menu and two memory cards
inserted, deleting the HEIF copy on the camera will also delete
the NEF (RAW) picture.

Record photos in NEF (RAW) format.

Record photos in HEIF format. “Fine” produces higher quality
pictures than “normal” and "normal” higher quality pictures than
"basic".
* Choose options with a star (“x") to maximize image quality.
Choose options without a star (“x") to ensure that the files are
more or less the same size.
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V] Taking Photos in HLG

* Pictures taken with HLG selected for tone mode exhibit more “noise” (in the form of randomly-
spaced bright pixels, fog, and lines) than do pictures taken using SDR.

* The performance of subject-detection may drop during autofocus.

* The lowest value available for the [ISO sensitivity settings] > [Maximum sensitivity] item in the
photo shooting menu is ISO 800.

* ISO sensitivities of Hi 0.3 through Hi 2.0 are not available.

* The video file type for time-lapse videos is fixed at [H.265 10-bit (MOV)].

* [Color space] in the photo shooting menu is fixed at "BT.2100".

* [Active D-Lighting], [Multiple exposure], and [HDR overlay] are not available in the photo
shooting menu.

* [C30], [C60], and [C120] cannot be selected for release mode and Custom Setting d3 [Pre-Release
Capture options] is not available.

* Buffer capacity drops when [Large] is selected for [Image size settings] > [Image size].

(% cautions: HLG Photos
¢ Photos shot with HLG selected for tone mode are subject to the following restrictions:

- Image overlay is not available with HLG photos. HLG photos will not be displayed in the picture
selection dialogs for the various image overlay options available via [Retouch] in the playback i
menu.

- The SnapBridge app can be used to download but not to view HLG photos.

¢ Photos taken with HLG selected for tone mode may not display correctly on monitors that are not
HDR-compatible.

% camera Shooting and Playback Displays

When HLG is selected for tone mode, the shooting and playback displays in the camera monitor and
viewfinder may include “noise” in the form of randomly-spaced bright pixels, fog, or lines or may fail
to accurately reproduce highlights and highly-saturated colors. In addition, abrupt tone discontinuities
may be visible in the camera monitor or viewfinder when photos are displayed full-frame, although the
photos themselves are unaffected. For accurate tone reproduction, use monitors, computers, operating
systems, applications, and other equipment compatible with HDR.

10 Configuring the Camera for HLG



Tip: Editing HLG Photos
* HLG photos can be edited on the Z 8 using the [Retouch] item in the playback ¢ menu. The
following options can be used:
- RAW processing (current picture; NEF/RAW pictures only)
- RAW processing (multiple pictures; NEF/RAW pictures only)
- Trim
- Resize (current picture)
- Resize (multiple pictures)
- D-Lighting
- Straighten
- Distortion control
- Perspective control
- Monochrome
* HLG photos can also be edited using Nikon's NX Studio software. The options available vary with
the file format. For more information, see “Editing (Enhancing) HLG Photos in NX Studio” (L 18).

Tip: RAW Processing

* NEF (RAW) photos shot with HLG selected for tone mode can be converted to JPEG or HEIF using
the [Retouch] item in the playback i menu (RAW processing). During this process, Picture Controls
and settings such as exposure compensation and white balance can be freely adjusted. Note,
however, that the JPEG copies may exhibit more “noise” in the form of randomly-spaced bright
pixels, fog, or lines than do JPEG copies created from NEF (RAW) pictures taken with SDR selected
for tone mode.

* NEF (RAW) photos can also be saved in other formats using Nikon's NX Studio software. For more
information, see “Saving Pictures in Other Formats Using NX Studio” ( L 25).
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Viewing HLG Photos on a Computer

What You'll Need

The following are the system requirements for the correct display of tones when viewing HLG photos.

| Windows
* Windows 11
0s . Windov.vs 10
- Version 1709 or later
- Latest graphics driver (WDDM)
GPU HDR10 compatible with support for PlayReady digital rights
management (DRM)
Monitor DisplayHDR 1000 (recommended)
HDMI 2.0a or later
Cable .
DisplayPort 1.4 or later
Software NX Studio (be sure to install the latest version)

[ Monitors That Do Not Satisfy the DisplayHDR 1000 Standard
Highlights in HLG photos may seem “washed out” when viewed on DisplayHDR/True Black 400, 500, or
600 monitors.
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o NX Studio

To display HLG photos, you will need to install Nikon’s NX Studio software. Doing so allows you to
view and edit photos and videos shot with Nikon digital cameras. Download the latest version of
the NX Studio installer from the website below and follow the on-screen instructions to complete
installation.

https://downloadcenter.nikonimglib.com/

V] Installing the Codec
Viewing HLG photos in NX Studio requires the corresponding “Imaging Codec 01" codec. The codec
can be installed by following the instructions displayed the first time an HEIF-format (extension “.hif")
HLG photo is opened, selected, or saved in another format in NX Studio.

* You must provide the camera serial number before downloading Imaging Codec 01.

e Configuring Your Computer

The computer must be configured as described below. More information on the settings below is
available from the Microsoft website.

¢ Enable HDR in Windows display settings.

¢ Enable HDR video streaming.

V] Displaying HLG Photos in Single-Frame View

Selecting high values for HDR/SDR brightness balance will brighten the entire display, making the
difference between HLG and non-HLG (SDR) photo displays difficult to discern. Selecting the lowest
setting for HDR/SDR brightness balance when viewing HLG photos brings the mid-tones for HDR
closer to those for SDR, making the HDR effect easier to see.

Tip: Monitor Settings
Depending on the model, you may need to adjust settings on your monitor. See the monitor
documentation for more information.
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§ macos

Liquid Retina XDR (including built-in MacBook Pro displays) or Pro

Monitor .
Display XDR

Software NX Studio (be sure to install the latest version)

[ Other Monitors

Highlights in HLG photos may seem "washed out” if not viewed on a Liquid Retina XDR or Pro

Display XDR monitor. This can sometimes be addressed by lowering display (monitor) brightness in the
computer’s system settings.

o NX Studio

To display HLG photos, you will need to install Nikon’s NX Studio software. Doing so allows you to
view and edit photos and videos shot with Nikon digital cameras. Download the latest version of
the NX Studio installer from the website below and follow the on-screen instructions to complete
installation.

https://downloadcenter.nikonimglib.com/

e Configuring Your Computer

You will need to select the "HDR Video (P3-ST 2084)" reference mode preset in display settings. More
information is available from the Apple website.

14 Viewing HLG Photos on a Computer


https://downloadcenter.nikonimglib.com/

Viewing HLG Photos on a Computer

¢ HLG photos are identified by “HLG" icons in the NX Studio thumbnail list.

@ nxtudio  DSC_0007.hif = X
r Image Adjust View Window Help

a

¥ Navigation

Y 42 Neme

File Camera Information

¥ File Info 1

¥ Favorite Folders

& Primary Destination

¥ Folders

¥ CameraInfo

jth 24mm
A
ingl

R: ON (SPORT)
OFF

50 Nikon Adobe RGB 4003001
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* The [File Info 2] pane in the info tab of the adjustments/info palette lists the tone mode as "HLG",
while the [Image Settings] pane lists the color space as "BT.2100".

Adjustments Info AMP/IPTC

File Camera Information [ |

® File Info 1

¥ File Info 2

A7272022 120!

HEIF Basic (10-

Camera Info
Exposure
Flash

Image Settings

ET.2100
UM (Mormal])
OFF
OFF
MNeormal
rtion Control:  ON
Diffraction Compensation: ON

Skin softening:  OFF
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§ Ensuring That Tones Are Displayed Correctly

"HDR" icons appear at the bottom right corners of HLG photos displayed in single-frame view in
NX Studio on HDR-compatible monitors. This indicates that tones are displayed correctly.

@ nx studio  DSC_0007.hif = x
File Edit Browser Image Adjust View Window Help

¥ Navigatio m R E - =Y (Neme

XMP/IPTC
Original Value

o e 5

¥ Adjust Brightnes
Original Val

Brightness

Monitors That Do Not Satisfy the DisplayHDR 1000 Standard
Highlights in HLG photos may seem “washed out” when viewed on a Windows computer with a display
that does not satisfy the DisplayHDR 1000 standard.
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Editing (Enhancing) HLG Photos in
NX Studio

HLG photos can be edited (enhanced) using the tools in the [Adjustments] tab of the NX Studio
adjustments/info palette. The following tools are available.

Adjustments Info

Current

2t & ~

Adjust using HDR
¥ Bacic Edit Palettes
* Set Picture Control (HLG)
» White Balance
» Exposure Comp.
8 Curves
Original Yalue

RGE
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[Basic Edit Palettes] (RAW pictures only)

* Picture Controls
* White balance
* Exposure compensation

Adjust using HDR

¥ Basic Edit Palettes
# Set Picture Control (HLG)
* White Balance

» Exposure Comp

[Levels & Curves]

* Contrast
» Tone curves (brightness)
* Color balance

Cunves
Original Value

RiGE

[Portrait Enhancements] (RAW pictures only)

« Skin softening
* Portrait impression balance

¥ Portrait Enhancements

* Skin softening

* Portrait impression balance
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[Adjust Details] (RAW pictures only)

* Noise reduction

¥ Adjust Details

* Moise Reduction

[Touch-up]
* Retouch brush

¥ Touch-up

* Retouch Brush

[Adjust Composition]

* Crop
 Straighten
 Perspective control

¥ Adjust Composition
* Crop
* Straighten

* Perspective Control

[Camera and Lens Corrections]

« Lateral color aberration

* Auto distortion control

* Vignette control

« Diffraction compensation (RAW pictures only)
 Fisheye

¥ (Camera and Lens Corrections

* Lens Corrections
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Enhancing HLG Photos

Enable [Adjust using HDR] in the [Adjustments] tab. Enabling this option allows edits to photos in
the HDR tone range.
¢ Remove the check to use the SDR tone range.

(@ NX Studio  * DSC_OD02NEF

Adjustm

Original Value

B M

B EH @ bk

21 Editing (Enhancing) HLG Photos in NX Studio



Picture Controls (HLG)

Enabling [Adjust using HDR] enables the [Set Picture Control (HLG)] Picture Control tool. Note that
HLG Picture Controls are available only with RAW pictures taken with HLG selected for tone-mode.
¢ The Picture Control tool changes to [Set Picture Control] when [Adjust using HDR] is disabled.

Adjust using HDR

¥ Basic Edit Palettes

¥ Set Picture Control (HLG)

¥ Recorded Value (STAMDARD ...
Quick sharp
L
Sharpening
@

Mid-range sharpening

Clarity

Contrast

Highlights

Saturation
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@ Color reproduction process: Fixed at [Camera compatible]; cannot be changed.
@ Picture Control: Choose a Picture Control for the pictures in the current selection.

@ Picture Control parameters: Adjust Picture Control parameters. Note that even in the case of

pictures taken under similar conditions, the results may vary with exposure and the position and
size of the subject in the frame.

@ [Reset]: Reset all parameters to their default values.

[ caution: Enabling or Disabling “Adjust Using HDR"
Enabling or disabling [Adjust using HDR] resets all Picture Control settings.
* Disabling [Adjust using HDR] after choosing [[HLG SD] Standard], [[HLG MC] Monochrome],
or [[HLG FL] Flat] for [Set Picture Control (HLG)] changes the selection to the corresponding
[Picture Control] option, respectively [Standard], [Monochrome], or [Flat].

| Picture Control (HLG) Parameters

Adjust Picture Control parameters. The parameters available vary with the Picture Control selected.

[Quick sharp]

Quickly adjust levels for balanced [Sharpening], [Mid-range sharpening], and [Clarity]. The various
sharpening parameters can also be adjusted individually.
» [Sharpening]: Control the sharpness of details and outlines.
» [Mid-range sharpening]: Adjust the sharpness of patterns and lines at levels of detail between
those to which [Sharpening] and [Clarity] apply.
» [Clarity]: Adjust overall sharpness and the sharpness of thicker outlines without affecting
brightness or dynamic range.

[Contrast]

Adjust contrast. Choose lower values for less contrast, higher values for more contrast.
[Highlights]

Adjust brightness in bright areas of the photo (highlights). Choose higher values for greater
brightness.

[Shadows]

Adjust brightness in dark areas of the photo (shadows). Choose higher values for greater brightness.
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[Saturation]

Control the vividness of colors. Choose lower values for more muted colors and higher values for
more vivid colors.

[Hue]
Adjust hue.

[Filter Effect]

Simulate the effects of color filters on monochrome photos. This parameter is available only with the
[[HLG MC] Monochrome] Picture Control.

[Toning]

Choose a base tint for results that mimic the effects of printing photos on tinted paper. This
parameter is available only with the [[HLG MC] Monochrome] Picture Control.

[Adjust Saturation]

Choose the saturation of the tint selected for [Toning]. This parameter is available only with the
[[HLG MC] Monochrome] Picture Control. Note, however, that saturation cannot be adjusted when
[B&W] is selected for [Toning].
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Saving Pictures in Other Formats Using
NX Studio

NX Studio can be used to create JPEG, HEIF, or TIFF format copies of photos taken with HLG selected
for tone mode. RAW (NEF) and HEIF photos can be viewed in third-party software that does not
support these formats by converting them to JPEG or TIFF. If desired, entire folders can be selected for
conversion to other formats.

Saving Pictures in Other Formats: An Overview

T Click [Export] in the toolbar.

O noxstu X
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2 A dialog will be displayed where you can adjust image quality, size, and other settings.

« For information on the options available, see “Export Options” ( L 28).

Export x

Original Image: |Selected images

Browse...
Indude subfolders Delete originals after operation
Export as: | JPEG e Mumber of files: 1
Estimated total size: 7 MB

Quality: Good Quality
0
[]resolution 300 dpi

[] change image size (Criginal Image Size: 6048 * 4024 pixels)
Long edge: | 5043 = Shortedge: 4024 Unit: | piscels

|:| Remove camera setting information
[Jremove ¥MPIFTC information

[ add/Remove ICC color profile Add Remove

Save in: |Specified folder b

Destination folder: C:\Users\userPictures Browse. ..

[Jcreate a new subfolder for each export Maming Cptions...

[ change file names Maming Cptions...
Export Cancel
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3 Click [Export].

Save in: |Speciﬁed folder V|
Destination folder: C:\Users\useriPictures
[]create a new subfolder for each export MNaming Options...
[] change file names —_—ntions...
| Export |W cancel

* The copies will be saved in the selected folder.

ﬂ RAW Pictures

[Export] can be used to save RAW pictures in other formats. To save RAW pictures without converting
them to other formats, use [Save] or [Save As] in the [File] menu. More options for use when saving
pictures can be found in the [Save] section of the [Options] dialog.
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Export Options

The following settings can be adjusted:

[Original Image]
Export the pictures in the current selection or in selected folders.
* [Selected images]: Export the pictures in the current selection.
¢ [Selected folder]: Export all pictures in a selected folder. To choose the folder, click [Browse].
- [Include subfolders]: Include pictures in all sub-folders under the selected folder.
- [Delete originals after operation]: Delete the original pictures from the folder once export is

complete.

[Export as]
Choose a format for the exported files from [JPEG], [TIFF (8 Bit)], [TIFF (16 Bit)], [HEIF (HLG)], and
[HEIF (PQ)].
o Files with thumbnails marked “PQ” cannot be saved in other formats.
¢ [HEIF (HLG)] and [HEIF (PQ)] will be available only if the thumbnail for the source file is marked
"HLG".
¢ The estimated total size is not displayed when an HEIF option is selected.
 [Quality]: Choose the compression ratio for pictures exported in JPEG or HEIF format. The JPEG
compression ratio can be selected by dragging the slider or entering the desired value. In the
case of HEIF, Windows offers a choice of [Highest Compression Ratio], [Good Compression
Ratio], [Good Balance], [Good Quality], and [Excellent Quality]. macOS does not offer a choice
of HEIF compression settings.
¢ [Use LZW Compression]: This option is available when pictures are saved in TIFF format. Select it
to compress the files using a lossless LZW compression algorithm.

I Lzw Compression
Enabling LZW compression when converting pictures to 16-bit TIFF may increase file size.

% “HEIF (HLG)” and "HEIF (PQ)”
Pictures exported with [HEIF (HLG)] or [HEIF (PQ)] selected for [Export as] will be saved
respectively in HLG or PQ (Perceptual Quantization) HEIF format.
» While HLG and PQ formats both conform to the HDR standard, they differ in the following
respects.
- HLG represents luminosity as a relative value, meaning that luminosity varies with the device
on which the picture is displayed.
- PQ represents luminosity as an absolute value, meaning that luminosity does not vary with the
device on which the picture is displayed.
* Pictures converted to PQ HEIF using the [HEIF (PQ)] option have thumbnails marked "PQ" and
can no longer be edited in NX Studio.
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[Resolution]

Export pictures at new resolutions.

[Change image size]
Resize pictures during export. Entering a value for [Long edge] automatically updates [Short
edge] to maintain aspect ratios. The units can be selected from [pixels], [inch] (inches), and [em]
(centimeters).

[Remove camera setting information]

Strip shooting data from pictures during export.

[Remove XMP/IPTC information]
Strip XMP/IPTC information from pictures during export.

[Add/Remove ICC color profile] (not displayed when [HEIF (HLG)] or [HEIF (PQ)] is selected for
[Export as])

To add or remove color profiles, select this option and choose [Add] or [Remove]. The profiles
added when [Add] is selected vary with the option selected for [Color Management] in the
[Options] dialog. The color profiles available for [Color management] are described below.

« If only [Use this instead of an embedded profile when opening images] is selected, the
[Default RGB color space] profile (or in macOS, [RGB Default Profile]) will be embedded in
pictures during export.

« If only [Convert images to sRGB color space when they are converted into JPEG/TIFF
format] is selected, the sRGB color profile will be embedded in pictures during export.

« If both are selected, the SRGB color profile will be embedded in pictures during export.

« If neither is selected, the original color profile will be embedded in pictures during export.

[Save in]
Choose the destination folder for the exported pictures.
» [Same folder as originals]: Save the exported pictures to the same folders as the original files.
« [Specified folder]: Save the exported pictures to a selected folder. To choose the destination,
click [Browse].
- [Create a new subfolder for each export]: Automatically create a new sub-folder within the

chosen folder each time pictures are exported. To choose how the folders are named, click
[Naming Options].

[Change file names]

Rename files during export. To choose how the files are named, click [Naming Options].
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Converting Pictures to Color Spaces Other than
sRGB

RAW pictures taken in the sRGB color space can be converted to other color spaces during export.

Note, however, that the color space for RAW pictures recorded with HLG selected for tone mode is
fixed at BT.2100, regardless of the color space selected at export or in the options (preferences) dialog.

T Choose the desired default RGB color space for [Options] > [Color Management] > [Color
Matching Profile] and select [Use this instead of an embedded profile when opening

images].
Options X
General Color Matching Profile
Thumbnail
umonal Default RGE color space
Wiewer .
Favorite Folders Mikon Adobe RGE 4.0.0.3001 ~
Dialog/Alert
|a o9/l Use this instead of an embedded profile when opening images
Color Management
Levels & Sampling
Open with Application Printer Profile
XMP/IPTC Preset |:| Use this profile when printing
Labels
View
MNEF [RAW] Processing
Web Service RIEDE
Video Perceptual
Save
Display Profile
Change Display Profile...
Output
[ convert images to sRGE color space when they are converted into JPEG/TIFF format
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2 Remove the check from [Convert images to sRGB color space when they are converted

into JPEG/TIFF format] under [Output] in the [Color Management] panel.

Options

General

Thumbnail

Viewer

Favorite Folders
Dialog/Alert

Color Management
Levels & Sampling
Open with Application
XMP/IPTC Preset
Labels

View

MNEF [RAW) Processing
Web Service

Video

Save

Color Matching Profile
Default RGB color space

Nikon Adobe RGE 4.0.0.3001

w

[ Use this instead of an embedded profile when opening images

Printer Profile

[use this profile when printing

Intent:

Perceptual

Display Profile

Change Display Profile...

Output

D Convert images to sRGE color space when they are converted into JPEG/TIFF format
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3 Select the desired option for [Options] > [NEF (RAW) Processing] > [Color Space for Color
Reproduction].

Options

General Color Space for Color Reproduction
Thumbnail

Viewer

Favarite Folders
Dialog/Alert Sizes Medium/Small for MEF [RAW) Images
Caolor Management
Levels & Sampling
Open with Application

Adobe RGE w

Perform recommended processing

XMP/AIPTC Preset DX RAW Default

Labels EMP (3008 x 1960)
View

MEF (RAW] Pracessing .

Web Service Color Reproduction Process
Videao O Latest Picture Control
save @Camera compatible

Tip: “Color Space for Color Reproduction”
The current color space for color reproduction can be viewed using the i button on the camera.
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4 Select [Export] > [Add/Remove ICC color profile] and choose [Add].

Export >

Original Image: |Selected images

Browse. ..
Indude subfolders Delete originals after operation
Export as: | JPEG w Mumber of files: i
Estimated total size: 7 MB

Quality: Good Quality

[Jresolution 300 dpi
ange image size (Original Image Size: = pixels
[]change i ize (Criginal I Size: 5048 = 4024 pixels)
Long edge: | 6043 = Shortedge: | 4024 Unit: | pixels

|:| Remove camera setting information

| Fep— ARAT TP e e i

Add/Remove ICC color profile (®) Add (I Remove

Save in: | Spedfied folder w

Destination folder: C:\Users\useriPictures Bane
[Jcreate a new subfolder for each export Maming Cptions...
[] change file names Maming Cptions...

Export Cancel

5 Click [Export].

* The pictures will be exported in the selected color space.
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Tip: Restoring the sRGB Color Space
To restore pictures to the sRGB color space:
* select [SRGB] for [Options] > [NEF (RAW) Processing] > [Color Space for Color Reproduction],
* place a check next to [Convert images to sRGB color space when they are converted into JPEG/
TIFF format] under [Output] in the [Color Management] panel, and
* select [Nikon Adobe sRGB 4.0.0.3002] for [Options] > [Color Management] > [Color Matching
Profile] and remove the check from [Use this instead of an embedded profile when opening
images].
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Troubleshooting

Problems and Solutions

e HLG (HEIF) photos do not display correctly:

Pictures taken with HLG selected for tone mode may not display correctly when viewed on other
devices (for example, when output to other devices directly or when opened on a computer after
upload). View the pictures on an HDR-compatible computer or other device. For more information
on viewing HLG pictures on a computer, visit the following website:
https://onlinemanual.nikonimglib.com/notice/hlg_setting guide/en/

e Output to HDMI devices does not function as expected:

Photos taken with HLG selected for tone mode may not display correctly on devices that are not
HDR-compatible.

o The effects of [Set Picture Control], [Set Picture Control (HLG)], [Active D-Lighting], or
[Vignette control] are not visible when pictures are viewed on a computer:

In the case of NEF (RAW) pictures, the effects can (as of May 2023) only be viewed using Nikon
software. View NEF (RAW) pictures using NX Studio.
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